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TEACHER OVERVIEW UNIT OF STUDY NO.

Renewable Energy
Resources for Texas
For Grades 6, 7 and 8
OVERVIEW

REQUIRED MATERIALS

In this unit students will learn about renewable energy
and the various resources that are available in Texas.
Students will engage in an Internet-based activity in
which they will research an assigned renewable energy
resource and make a presentation on the resource to
the class.

•
•
•
•

OBJECTIVES
See Middle School Teacher Resource Guide for TEKS
objectives and additional information regarding this
and other middle school units.

SUGGESTED TIMEFRAME
Teacher will need to determine how many class periods
to devote to each activity, based on the suggested
timeframe and length of classes.
Time
10 minutes
15 minutes
45 minutes

Activity
Activity 1 – Teacher
Introduction
Activity 2 – Assessment of
Current Student Knowledge
Activity 3 – Reading Passage
and Vocabulary
Homework Assignment
– Sentences with Vocabulary

Content
Area

Science
Reading
Vocabulary
Language Arts

30 minutes
60 minutes

Activity 4 – Pre-Lab
Activity 5 – Internet Research

Science
Technology

60 minutes

Activity 6 – Group
Presentations

Science
Language Arts

30 minutes

Activity 7 – Assessment

Science

Activity 8 – Follow Up Activity

Technology

90 – 120 minutes
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•

copy of the Reading Passage and Student Data
Sheets (includes reading comprehension questions,
vocabulary and Lab Activity) for each student
copy of the Assessment Questions for each student
Internet access
a website composition program such as Netscape
Composer program (a part of Netscape Navigator,
free download online at www.netscape.com) Note:
the instructions contained in the activity were
written for Netscape Composer but can be adapted
for other web page creation programs
a presentation software program such as Microsoft
PowerPoint or equivalent

SUMMARY OF ACTIVITIES
Activity 1 – Teacher Introduction (10 minutes)
Explain to the class that for the next unit of study,
they will be learning about renewable energy and the
resources available in Texas. If resources are available,
have some solar-powered gadgets on hand to capture
the students’ attention. Hobby, home, electronic and
sports supply stores and catalogs offer a variety of
items from solar-powered toys, calculators and battery
chargers to garden lights, flashlights and radios. These
will provide hands-on attention getters. The purpose
of this unit is to introduce to students various forms of
renewable energy that will be explored in detail during
the Internet research activity. The class will be divided
into several groups and assigned a particular renewable
energy technology. Each group must research their
topic using suggested guidelines for content. Each
group will compile information including graphics and
tables and make a presentation on their assigned topic.
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Activity 2 – Assessment of Current Student
Knowledge (15 minutes)
To assess what students already know, prompt a class
discussion based on the 3 questions listed below.
Based on this discussion, create and display a graphic
organizer of the points that were discussed, which can
be displayed throughout the unit of study. Refer to the
Teacher Resource Guide for sample organizers.
1. What is renewable energy? What are fossil fuels?
2. Is anyone familiar with or has anyone seen
applications of any of the following types of
energy: solar, wind, biomass, hydroelectric,
geothermal or tidal?
3. Does Texas have any renewable energy resources?
Since many of the renewable energy terms are
unfamiliar to students, make the words contextually
relevant to them. This can be done by discussing each
word in terms of something they are familiar with. For
example, the term hydroelectric has the prefix “hydro”
that means water, similar to fire hydrant that is a
source of water. Or photovoltaic: “photo” means light
(as in photosynthesis) and volt means electricity (as in
a 9 volt battery). Later when the discussion includes
passive solar energy, the word passive can be clarified
by a similar discussion such as the following: “When
you are sitting in front of the television set, you are
passively listening and learning as there is no movement
or reaction that needs energy between you and the
television. Similarly, a passive solar water heating
system requires no moving parts and no external energy
source except the presence of the sun itself.”
See Teacher Resource Guide for alternative or
additional assessment activity.

Activity 3 – Vocabulary and Reading Passage
(45 minutes)
Each student will need a copy of the Reading Passage
and the Student Data Sheets, which include reading
comprehension questions, vocabulary words and the
Internet Research Activity. (As an alternative to making
copies, the Study Data Sheets can be displayed so the
entire class can view them and copy the information
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into their science notebook.) Instruct students to study
the Reading Passage, “Renewable Energy Resources for
Texas,” and complete the questions and vocabulary. This
activity will introduce students to renewable energy and
provide them with a basic background for expanding
their knowledge of specific resources during the Internet
Research Activity. Key vocabulary words in the Reading
Passage will assist them during their research. At the
end of this activity, collect and grade the student’s work.
Return their graded work the following day.
Homework Assignment – Key Vocabulary List
1. Instruct students to create in their science
notebooks meaningful sentences that reflect an
understanding of the definition of each vocabulary
word. Students should have written the definition
of the words in their science notebooks during
class. See Teacher Resource Guide for alternative
vocabulary homework.
2. Collect and grade this assignment the next day.

Activity 4 – Pre-Lab (30 minutes)
1. Explain to the class that the purpose of the Lab
Activity is to expand their knowledge of renewable
energy by researching a particular technology in
depth.
2. Divide the class into groups of 2 – 3 students and
assign each group one of the following types of
renewable energy. The number of groups and the
group size will depend upon access to computers.
The teacher can decide to increase or decrease the
number of groups and topics:
• solar electricity (photovoltaics)
• solar thermal (can include water heating, space
heating, or solar cooking)
• passive solar energy
• wind energy
• biomass energy
• geothermal energy (can include heat pumps and
large-scale power plants)
• hydroelectric energy
• tidal or wave energy
3. Review the Internet Research Activity Guidelines
with the students so they understand the
components of their research. Teacher should add
additional topics as appropriate.
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4. There are several good search engines on the
Internet, such as google.com, yahoo.com, lycos.
com, askjeeves.com and hotbot.com (as of 2005).
The teacher can recommend a particular engine or
provide a list. Refer to the Teacher Resource Guide
for further instructions on how to conduct Internet
research using these engines.

Activity 5 – Internet Research Activity
(60 minutes)
1. Research: Instruct each group to research their
assigned topic using the Internet Research Activity
Guidelines. Teacher can determine whether
students should save their information to a disk
(floppy or CD) or if the information can be saved
directly onto the computer hard drive. Teachers
can either distribute disks to students or request
that they bring one from home. If saving research
information to the hard drive, students can
create their own folder named appropriately on
the computer hard drive and save their research
information in their folder.
2. Compilation: Groups should compile their
information and organize it into a presentation
based on the Internet Research Activity Guidelines.
Inform each group that they will be allowed 10 to
15 minutes to present their topic and to organize
their information accordingly. Encourage groups to
divide the presentation among all group members
so each student has an opportunity to present a
piece of their topic.
3. Topic quiz: Groups should develop 5 questions
based on the information they present that
will serve as a class quiz. This will hold the
class responsible for paying attention to the
presentations. Students should administer the quiz
at the conclusion of their presentation. The quiz
can be the last slide of their computer presentation,
done orally or written on the board. Each group
can decide if they want the whole class to answer
the questions together or if they want each student
to answer the questions individually. They should
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present the questions and call upon students to
give the answers orally, or they should instruct the
class to individually write the answers. Students can
then check and grade each other’s work.

Activity 6 – Group Presentations (60 minutes)
1. Allow each group 10 to 15 minutes (including
setup) to present their topic.
2. Allow time for questions after each group. Once all
the groups have presented, wrap up the discussions
and summarize the findings. The new information
can be added to the graphic organizer generated
during the initial class discussion.
Activity 7 – Assessment (30 minutes)
Distribute a copy of the Assessment Questions to
each student. Instruct each student to work alone and
answer the short answer and multiple-choice questions.
Collect the handouts, grade and return them to the
students.

Activity 8 – Follow Up Activity (90 – 120 minutes)
Inform students that during this activity they will
create web pages based on the research they gathered
on their assigned renewable energy resource. The
electronic information they collected (text, graphics,
links, etc.) will be used as the content of their web
page. Students should work in the same groups
from the Internet Research Activity. Review with the
class the basic steps to creating a web page based on
instruction included in the Follow Up Activity Student
Data Sheet. Students will turn in a hard copy print out
of their web pages with the file name and computer
identified. Teacher should view the web page on the
computer as the final step.

ADDITIONAL ACTIVITY
Renewable Energy Resources in Texas
Using a blank template of the state of Texas and colored
pencils, instruct students to shade in the areas where
the solar, wind and biomass potential are the greatest.
Each color should represent a different form of energy.
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TEACHER
READINGOVERVIEW
PASSAGE

Renewable Energy
Resources for Texas
HIGHLIGHTS
• Texas has more renewable energy
potential than any other state
• Every Texas community can
use clean, renewable energy
affordably
• Developing Texas’ renewable
resources will help the State’s
economy

SUMMARY
Due to its size and diverse climate, Texas has
tremendous potential to use clean, renewable
energy resources such as wind, solar and
biomass. These resources are plentiful, large
enough in fact to meet all of our State’s
energy needs. These technologies do not
create pollution and are available as large
systems (power plants) and as smaller systems
(for home use). Thanks to rules established by
the Texas government, our State must have
2,000 Megawatts of electricity that comes
from renewable resources by the year 2009.
Not only does renewable energy help our
environment, but it also means good business
and creates jobs for our local communities.
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WHAT IS RENEWABLE
ENERGY?
Renewable energy is energy that comes
from sources that are always available in
the natural world and cannot be used up.
Following are examples of renewable energy
and their resources:
• Solar energy – energy that is produced from
the sun whether it is in the form of sunlight
particles that can create electricity (solar
electricity or photovoltaics) or in the form
of heat to warm water or air space
• Wind energy – energy that is produced
from the natural movement of the wind;
also considered a form of solar energy
because wind is created by differences in
the amount of heat that the sun sends to
different parts of the earth
• Biomass energy – energy that comes from
materials that were once living like plants
or some types of garbage
• Geothermal energy – energy that comes
from heat generated deep inside the Earth
from items like hot rocks, hot water and
steam
• Hydroelectric energy – energy that is
produced from moving or falling water
• Tidal/wave energy – energy that is
produced when ocean tides or waves
change or move across the ocean or sea
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RENEWABLES HAVE “TEXAS
SIZE” POTENTIAL

TEXAS
MONTANA
KANSAS
NORTH DAKOTA
SOUTH DAKOTA
WYOMING
NEBRASKA
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NEW MEXICO
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SOLAR

OKLAHOMA
0

1

2

3

4

5

6

7

8

9

10

RENEWABLE ENERGY PROTENTIAL (quads)

TEXAS IS #1 IN RENEWABLE POTENTIAL This figure, based
on a study done for the United Nations, shows that Texas can
develop more clean, renewable energy than any other state.

All of these forms of energy are made
directly from the sun (solar), indirectly from
the sun (wind, hydropower and biomass) or
from other movements of our natural world
(geothermal and tidal/wave energy). The most
common types of renewable energy in Texas
are solar, wind, and biomass.

Texas has large amounts of fossil fuel resources
such as oil, gas, coal and uranium. But the
State has even more renewable resources that
make those fossil fuel resources look small.
The wind, solar and biomass potential in Texas
is equal to 4,330 quadrillion British Thermal
Units (BTUs) per year, or about 400 times
the amount of energy our State uses per year.
Wind energy alone could provide eight times
as much power as all of the State’s electric
power plants combined. And our potential
for solar energy is even greater than wind!
In order to meet our energy needs in Texas,
we only need to use a small fraction of the
renewable energy resources that are available.

WHERE ARE THE RESOURCES
LOCATED?
No matter where you are in Texas, renewable
energy resources are, more than likely,
all around you. Some forms of renewable

Renewable Energy
Major Resource Areas
BIOMASS

TEXAS BIOMASS
POTENTIAL East Texas
and parts of north and
central Texas are ideal
for growing biomass
resources.
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Renewable Energy
Major Resource Areas
SOLAR

TEXAS SOLAR POTENTIAL
Sunlight is strongest in west
and north Texas, although
small solar projects are practical
everywhere in the state.
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Renewable Energy
Major Resource Areas
WIND

Renewable energy comes from nature in many
forms, each of which is best suited for certain
uses. Biomass in particular has many uses.
The solar energy stored in biomass can make
liquid fuels for cars (like ethanol), fuels in the
form of gas (like methane) that can be burned
in place of natural gas, or solid fuels like wood
chips that can be burned like coal.

LAND USE
TEXAS WIND POTENTIAL
The windiest locations in the
state can be found in north
and west Texas and along
the gulf coast.

energy such as solar heating, photovoltaics,
solar water heaters and geothermal (in the
form of heat pumps) can be used just about
everywhere in Texas. Other technologies,
such as biomass energy plants and water
pumping windmills, can be used in many
communities across the State.
However, for large power projects that use
wind and solar energy, the best locations
in the State should be found. For wind and
solar, the best areas are in south Texas,
west Texas and the Panhandle. The best
biomass resources are in east Texas and the
Panhandle. When you add it all up, Texas can
benefit from clean, renewable energy sources
in every community in the State.

Some people think that renewable energy
uses too much land to be practical. This is not
true. Renewable energy uses as much land as
that used by fossil fuels such as oil and gas.
Harnessing renewable energy can be done
along side other traditional land uses. For
instance, cattle can graze around windmills,
and solar equipment can be placed on the roofs
of factories, shopping centers and individual
houses, over parking lots and along roadways.

TEXAS
(170)

SOLAR
(.7)

WIND
(9)

Land Area Needed to
Produce All Electricity
Sold in Texas (270 GWh)

BIOMASS
(26)

OIL
(7)

GAS
(2)

numbers in parenthesis
are in millions of acres

RENEWABLE ENERGY USES
Renewable energy resources can fulfill
our energy needs that we often get from
fossil fuels. These needs include generating
electricity, providing heat, powering
mechanical equipment and powering vehicles.
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LAND AREA NEEDED FOR VARIOUS TEXAS ENERGY
SOURCES Each square shows the land area needed by
different energy resources to produce enough electricity for
the entire state of Texas. Oil wells and wind turbines produce
about the same amount of energy per unit of land area.
Unit of Study No. 7
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Understanding the Reading Passage
1. What is renewable energy? _______________________________________________________________
_____________________________________________________________________________________
_____________________________________________________________________________________
2. Briefly describe the following types of renewable energy in your own words:
•

solar energy ___________________________________________________________________________

•

wind energy __________________________________________________________________________

•

biomass energy ________________________________________________________________________

•

geothermal energy ______________________________________________________________________

•

hydroelectric energy ____________________________________________________________________

•

tidal/wave energy ______________________________________________________________________

3. Can renewable energy be used for our current energy needs? Why or why not? _______________________
_____________________________________________________________________________________
_____________________________________________________________________________________
4. Does renewable energy use too much land to be considered? Why or why not? _______________________
_____________________________________________________________________________________
_____________________________________________________________________________________
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Vocabulary
Based on the Reading Passage, write down your understanding of these words or word pairs and verify your
definitions in a dictionary, on the Internet if available or with your teacher:
biomass energy _________________________________________________________________________

British Thermal Unit (BTU) _______________________________________________________________

fossil fuels _____________________________________________________________________________

geothermal energy _______________________________________________________________________

heat pump _____________________________________________________________________________

hydroelectric energy _____________________________________________________________________

quadrillion _____________________________________________________________________________

potential _______________________________________________________________________________

renewable energy ________________________________________________________________________

resources ______________________________________________________________________________

solar energy ____________________________________________________________________________

tidal/wave energy ________________________________________________________________________

wind energy ____________________________________________________________________________
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Internet Research Guidelines
Researching Renewable Energy Resources
Introduction
The purpose of this activity is to expand your
understanding of renewable energy resources by
researching a specific technology as directed by
your teacher.
Before You Start
Review the vocabulary words from the Reading
Passage. Ask your teacher if you are unsure of
any of the meanings. Divide up all the steps in
the Lab Activity first, so that everyone has a clear
job to do.

• written electronic text in your own words
that addresses each aspect listed in #2 above;
• electronic graphics, such as photos, tables
or diagrams, supporting the information
gathered; and
• a list of resources with website links for
more information.
4. Save any information you gather from the
Internet on disk or the computer’s hard drive,
according to your teacher’s directions (text,
photos, diagrams, resource links, etc.).

Presentation Guidelines

Research Guidelines

1. Your presentation will be made using
computer software that is available to your
1. Receive your renewable energy technology
class (such as Microsoft PowerPoint).
assignment from your teacher.
2. Your teacher will provide guidelines for using 2. Organize your information so that when it is
presented, it follows a clear and logical flow
search engines on the Internet. Based on your
such as: introduction, main information,
assigned topic, use the Internet to research
conclusion and where to get more information.
the following aspects of your technology:
3. Your presentation should include all the
• description of the technology and the
components listed in #3 above.
renewable resource that powers it—include
how the resource and technology work and 4. Choose text colors, style, font size and
background colors that can be easily viewed
typical equipment components if applicable;
by the class.
• end uses or applications of the
5. The last part of your presentation will be
technology—include users;
a quiz for your classmates to answer. This
• where, if at all, the resource can be found
will make sure they pay attention to your
in the state of Texas;
presentation! Prepare 5 questions about your
• at least 1 sample project in Texas; and
assigned topic. You can present the questions
• conclusion stating whether the assigned
as the last slide of your presentation, read them
resource is practical, worthwhile and can
aloud or write them on the board. You can
be successfully used in Texas.
make the quiz for the whole class to answer
3. The research you compile should consist of
aloud or have students write the answers in
the following components at a minimum:
their notebooks and check each other’s work.
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Assessment Questions
1. What is the difference between renewable energy and fossil fuels? ___________________________
______________________________________________________________________________
______________________________________________________________________________
2. How much of our energy needs in Texas could we get from renewable energy? _________________
3. What types of renewable energy are the most common in Texas? ___________________________
______________________________________________________________________________

Multiple Choice Questions
1. The State with the greatest potential for using wind
energy is:
a) Oklahoma
c) Kansas
b) Texas
d) Wyoming

6. Energy that comes from materials that were once
living, like plants or some types of garbage, is called:
a) wave/tidal
c) biomass
b) hydropower
d) solar

2. The State with the most sunlight is:
a) New Mexico
c) Colorado
b) Montana
d) Texas

7. Energy that comes from heat generated deep inside
the earth from items like hot rocks, hot water and
steam is called:
a) wind
c) biomass
b) geothermal
d) solar

3. Biomass is derived from:
a) water power
c) plants and animals
b) solar energy
d) wind power
4. Renewable energies regenerated indirectly from the
sun include:
a) wind
c) energy stored in biomass
b) hydropower
d) all answers a, b, and c
5. Biomass is most prevalent in:
a) the Texas Panhandle c) south Texas
b) west Texas
d) east Texas
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8. Energy that is produced from moving or falling water
is called:
a) biomass
c) geothermal
b) hydroelectric
d) solar
9. A form of solar energy that creates electricity from
particles of sunlight is called:
a) plate-tectonics
c) tidal energy
b) geothermal
d) photovoltaics
10. The renewable energy source you would most like to
use is:
a) solar
c) biomass
b) wind
d) hydroelectric
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Follow Up Activity
Create a Web Page
In this activity, you will use the information you
gathered during the Internet Research Activity and
create a web page about your assigned renewable
energy resource. If you saved images, text and
information links on a disk, you can easily retrieve
them to include in your web page.
PART I – Organization of Information
Develop a general outline of how information will
be presented on your web page. Points to consider
include:
• flow of information (you can refer to the
presentation you made during the main
unit)
• titles and subtitles
• use of graphics (photos, diagrams, other
images, tables, graphs, etc.)
• layout and positioning of graphics on your
web page
• font size, color, spacing, etc.
PART II - Web Page Composition Instructions
Once you have decided your general approach
to the layout of your web page and keeping in

Format the web
page
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mind that the layout may change as you begin
composing, use the web composition software to
create your web page. Instructions are included for
Netscape Composer.
1. Access Netscape Composer. On the menu bar
go to > Communicator menu > Composer.
This will open a new document that will be
used to paste and generate text for your web
page.
2. Save this document by selecting > File menu
> Save As and give the document a new name.
As you create your web page, you should save
your file often so you do not lose any data.
3. If the information you created for your
Internet Research is on disk, get approval from
your teacher to copy it onto the hard drive of
your computer for easier access. Copy the files
into the same folder as the Netscape Composer
document you just created.
4. Begin creating your web page by typing
text (either new text or copied from the
information you gathered from your Internet
Research), inserting images, and creating links.
The following table describes common tasks
used in creating web pages:

To format the color, texture or image for the background of your web
page:
• Right Click any place on the blank page.
• Choose Page Properties.
• Choose a Background color or select a background image
• Set default colors
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Creating Text

Simply begin typing text in the new document you created in Netscape
Composer. If you are using documents you created for your Internet
Research, you can save time by cutting and pasting text segments between
your existing information and your new web page document. Use the
formatting buttons to center or align text as desired.

Changing Text
Color, Style and
Font

Open the Format menu and choose Character Properties; then click the
Character tab. Following are the available options:
• Font Face: click to select the font type you want.
• Font Size: click to select the size of the specified font. In the list of
font sizes, you will see a menu of point sizes (8, 9, 10, 12, 14 and so
forth), the relative HTML (Hyper Text Markup Language) font scale
(-2 to +4), or both. You can specify which type of menu you want in
the General panel of the Composer.
• Color: select Preference dialog box (Windows only). Click Use
Color and then click the color button to choose the color of the
selected characters. The color button is the rectangle to the right of
the “Use Color” button. If the current text color is black, then the
color button is black.

Inserting an Image

Insert GIF (Graphic Interchange Format) and JPEG (Joint Photographic
Experts Groups) images into your web page as follows:
• Click where you want the image to appear in your document
• Open the Internet file menu and choose the image
• Specify the image file and adjust settings in the Images Properties
dialog box
(TIP: To quickly insert an image, cut and paste it from the clipboard, or
drag and drop it onto your page. When you insert an image by pasting
from the clipboard or by dragging and dropping, either put a copy of
the image file in the same directory (folder) as the web page, or leave
the image file where it is on your hard disk or network. The settings you
specify in Composer Preference determine which method you use. To
quickly resize an image, select it and drag the handles that appear at each
corner.)

(NOTE: In a Mac
operating system, you
must have Quick
Time installed to
copy a PICT file
from the system
clipboard. Composer
prompts you to name
the image file before
you paste it and
converts the file to
JPEG format.)
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Linking within the
same page

To link within the same page, create a target and then create a link that
points to the target as follows:
• Put the cursor at the beginning of a line where you want to create
a target, or select some text at the beginning of a line.
• Open the Insert menu and choose the target.
• Type a name for the target in the edit box (up to 30 characters). If
you selected some text in step 1, this box already contains a name.
• Click OK. A Target icon (visible only in the Composer window)
appears in your document to mark the target’s location. Note:
Targets are also called anchors.
• Put the cursor on the text or image that you want to link to the
target.
• Open the Insert menu and choose the Link.
• Open the File menu and choose Browse Page; then click the link
you just created.

Linking to Other
Pages

Link to local pages on your own computer or on your school’s network,
or to remote pages somewhere on the Internet. You can quickly create
a link by dragging and dropping from other windows. For example,
you can highlight a link from a web page, bookmark, or mail and news
window and drag and drop it on your page. You can also create a link
using the Link Properties dialog box.
• Select the text or image you want to link to another page.
• Open the Insert menu and choose Link.
• Use the Link Properties dialog box to set up the link. The dialog
box is explained below.

Link Properties
Dialog Box

Use the Link Properties Dialog Box to insert a new link or modify an
existing link.
• Enter the text you want to link to another page or target. If you’ve
already highlighted an image or text, you see it here.
• Link to page location or local file.
• If you want to link your page to someone else’s page, type the local
path and file name or remote URL of the other person’s page. If
you’re not sure of the path and filename or a local file, click Browse
to find it on your hard disk or network.
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Targets

1. Targets are used to label sections of a page (such as top, bottom,
section headings) to navigate around the page. Once a target has been
placed on a page, a link may be made to navigate to the target.
• Position the cursor at the point where a target should be marked.
• Click the Target icon and give the target a name. In Composer a
target icon appears, but in Navigator the target is invisible.
2. Show targets as follows:
• Click Current File to see the named targets in the page you’re
currently editing.
• Click Selected File to see named targets in the file you specified
under “Link to page location or file,” above.

Removing a Link

Click to unlink the selected linked text. If the current selection contains
more than one link, an alert box appears asking you whether to remove
all links.

Linking to Images

You can make images behave as links in your pages. When the user clicks
a linked image, the browser window displays the page to which the image
is linked.
• Click to highlight an image on your page.
• Open the Insert menu and choose Link.
• Use the Link Properties dialog box to set up the link.
(TIP: Dragging a linked image from the Navigator window into a
Composer window copies both the image and the link.)

5. After you have created your web page, be sure
to save the final version. Print a hard copy of
the page and turn it in to your teacher with the
name of your file and the computer you were
using. Your teacher will decide if the web pages
your class created will become published on
your school website.
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TEACHER ANSWER KEY
Understanding the Reading Passage
1.

2.

3.
4.

Renewable energy is energy that comes from sources that are
always available in the natural world and cannot be used up.
They are made directly from the sun (solar), indirectly from the
sun (wind, hydropower and biomass) or from other movements
of our natural world (geothermal and tidal/wave energy).
•

solar energy – energy that is produced from the sun
whether it’s in the form of sunlight particles that can
create electricity (solar electricity or photovoltaics) or in
the form of heat to warm water or air space.
• wind energy – energy that is produced from the natural
movement of the wind; also considered a form of solar
energy because wind is created by differences in the
amount of heat that the sun sends to different parts of
the earth
• biomass energy – energy that comes from materials that
were once living like plants or some types of garbage
• geothermal energy – energy that comes from heat
generated deep inside the earth from items like hot rocks,
hot water and steam
• hydroelectric energy – energy that is produced from
moving or falling water
• tidal/wave energy – energy that is produced when ocean
tides or waves change or move across the ocean or sea
Yes. Solar and biomass alone could provide about 400 times
the amount of energy Texas uses per year.
Renewable energy uses as much land as that used by fossil fuels
such as oil and gas. However, harnessing renewable energy can
be done along side other traditional land uses. For instance,
cattle can graze around windmills, and solar equipment can
be placed on the roofs of factories, shopping centers and
individual houses, over parking lots and along roadways.

Vocabulary Definitions
biomass energy – energy that comes from materials that were
once living like plants or some types of garbage
British Thermal Unit (BTU) – the amount of energy
generated by burning a material; the amount of heat required
to raise the temperature of one pound of water one degree
Fahrenheit
fossil fuels – fuels formed in the ground after millions of
years by chemical and physical changes in plant and animal
residues under high temperature and pressure, such as oil,
natural gas and coal; fossil fuels emit pollutants into the air
when burned
geothermal energy – energy that comes from heat generated
deep inside the earth from items like hot rocks, hot water and
steam
heat pump – a heating and air conditioning unit that heats
or cools by moving heat
hydroelectric energy – energy that is produced from moving
or falling water
quadrillion – the number that is represented as a one
followed by 24 zeros (1,000,000,000,000,000,000,000,000)
potential – anything that may be possible

Assessment Questions

renewable energy – energy that comes from sources that are
always available in the natural world and cannot be used up;
typically non-polluting energy

1.

resource – a source of supply

2.
3.

Renewable Energy is energy that comes from sources that
are always available in the natural world and cannot be used
up. Fossil fuels were formed in the ground after millions of
years by chemical and physical changes in plant and animal
residues under high temperature and pressure and can be
used up. Renewable energy is typically clean, non-polluting
energy whereas fossil fuels emit pollutants into the air.
All of it.
Solar, wind, biomass and hydroelectric.

Multiple Choice Questions
1 b; 2 d; 3 c; 4 d; 5 d; 6 c; 7 b; 8 b; 9 d; 10 any

Unit of Study No. 7

No. 7

solar energy – energy that is produced from the sun whether
it is in the form of sunlight particles that can create electricity
(solar electricity or photovoltaics) or in the form of heat to
warm water or air space.
tidal/wave energy – energy that is produced when ocean
tides or waves change or move across the ocean or sea
wind energy – energy that is produced from the natural
movement of the wind; also considered a form of solar energy
because wind is created by differences in the amount of heat
that the sun sends to different parts of the earth

RENEWABLE ENERGY RESOURCES FOR TEXAS – 15

InfinitePower.org
Financial Acknowledgement This publication was developed as
part of the Renewable Energy Demonstration Program and was
funded 100% with oil overcharge funds from the Exxon settlement
as provided by the Texas State Energy Conservation Office and the
U.S. Department of Energy. Mention of trade names or commercial
products does not constitute endorsement or recommendation for use.

State Energy Conservation Office
111 East 17th Street, Room 1114
Austin, Texas 78774
Ph. 800.531.5441 ext 31796
www.InfinitePower.org
Texas Comptroller of Public Accounts
Publication #96-812B (03/05)

